
Microsoft Word 2003 

Lesson 1: The Basics 

Objectives: 
By the end of this section you will be able to: 

 Understand and use the common elements 
of a Windows program 

 Launch Word 

 Understand the Word screen 

 Use Toolbars 

 Use Menus 

 Get Help 



Windows Concepts 

Word is an application that runs under the Windows graphical user interface.  When 
launched, Word sits in its own “window” – the blue box that surrounds the application 
elements.  The window can be moved, sized, closed, minimised and maximised using the 
features common to the Windows environment which are listed below:  

 

Standard 
Toolbar 

Formatting 
toolbar 

Task Pane 

Status Bar 

 Figure 1 – Window elements 

 
Window Border The grey box that surrounds the Word screen when it is not 

maximised is called the window border.  When the mouse is over 
the border, the pointer changes from a single to a double-headed 
arrow. Clicking and dragging with this mouse pointer allows the 
window to be resized. 

Title bar  The coloured bar that appears at the top of the Word window is 
called the Title Bar. The Title Bar tells you which application you 
are using and if the document you are in is maximised, it will also 
contain the name of the document.  If the Word window is not 
maximised, by positioning the mouse over the title bar and 
clicking and dragging, you can move the Word window to a new 
location on the screen. 



 
Maximise button When working on a document, the Word screen contains two 

windows, an application window and a document window.  You 
can maximise both windows to use all the available space you 
have on-screen. If you would like the Word application window 
to fill up the whole screen, click the outermost maximise button.  
You may find that the document you are in could still be bigger – 
click the inner maximise button to fill the remaining space within 
the Word application window. 

Minimise button This button is very useful if you need to temporarily switch from 
Word into another application without closing Word down 
completely. By clicking the minimise button to shrink Word to an 
icon on the task bar, you will be able to view other icons on your 
desktop for additional applications you may wish to access. When 
you are finished and ready to continue word processing, click the 
Word icon from the task bar to resume.  Note that the innermost 
minimise button will minimise the current document window 
rather than the application window. 

Restore button This button only appears when a window is maximised.  A 
maximised window has no border and you can’t see what is 
behind it.  If you want to put the window back inside its border so 
that you can move and size it, click the restore button. 

Close button This button is used to close a window.  If you click the close 
button for a document window (the innermost close button), you 
close the document, the outermost button will close the Word 
application. 

Application Menu The application menu icon is located to the left of the Title Bar.  
When selected, it displays a pull-down menu with commands 
enabling you to resize or close the Word application.  This can 
also be accessed by pressing [ALT][SPACEBAR]. 

Note: Double click on this icon to close the application down. 

 



Getting Started  

Word 2003 is a windows based application and is therefore launched the same way as 
other applications.   

 

 To Launch Word: 
 

• Click on the Start button 

• Move up to Programs 

• Across to select Microsoft Word  

 

Or alternatively, a shortcut can be created and placed on the desktop to start 
Word. 

 

• From the windows desktop, double-click on the Microsoft Word 
icon. 

 

 

 

 



Screen Layout 

The diagram below indicates the elements visible on the Word screen.  Toolbar buttons 
all come equipped with screen tips which give extra information about the button’s 
function when the mouse is hovered over it.  The View selector buttons at the bottom left 
of the screen also have this feature.  

Title Bar  

 

 

Toolbars Menu Bar 

Task Pane 

Document 
Work Area 

Status Bar 

 

Title bar  
The Title Bar appears at the top of the Word window, registering the title of the 
application and the document you are working on. If the Word window is not maximised, 
by positioning the mouse over the title bar and clicking and dragging, you can move the 
Word window to a new location on the screen. 

Menus 
The menu bar contains menus giving access to all the commands that can be carried out 
in Word. There are two methods for accessing menus and their options - the menu bar 
and the shortcut menu.  



Menu Bar 
The menu bar displays all options available within Word.  You can access a menu by 
clicking its name with the left mouse button.  

 To select a menu bar menu: 
Mouse 
• Click on the menu title.  A pull-down menu will appear listing all 

options available. To reveal the 
rest of the menu click on the 
arrows at the bottom of the 
menu.   

• Click the required menu option. 

Or 
Keyboard 
• Hold down the [ALT] key and press the underlined letter of the 

menu title. 

• Type the underlined character of the required option within the 
menu. 

Shortcut menus 
Shortcut menus can only be accessed when the mouse is positioned over a piece of text in 
the document, by clicking the right mouse button.  The options that appear on the 
shortcut menus are context sensitive and may differ depending on what you have 
selected. 

 To select a shortcut menu option: 
Mouse 
• Click with the right mouse button over an item in your document. 

A menu will appear listing options available. 

 

 Figure 2 - Shortcut Menu 



• Click the required menu option. 

Toolbars 
Word has many different toolbars that can be displayed on the screen but the default 
toolbars are the Standard toolbar and the Formatting toolbar. 

The Standard toolbar contains buttons for commonly carried out operations such as 
opening a file, saving a file and copying information. The Formatting toolbar buttons are 
devoted to enhancing the appearance of text in a document.  When you hover 
your mouse over any toolbar button, Word will display a description of what 
the button does.  

Show and hide toolbars 
In addition to the Standard and Formatting toolbars, there are other toolbars in Word 
which give you access to buttons that relate to specific tasks, such as Drawing. These 
additional toolbars can be turned on or off at any time. 

 

 To show an additional toolbar: 
Mouse 
• Click the right mouse button anywhere over a 

displayed toolbar. 

• From the shortcut menu, click the toolbar you 
want to show. 

 To hide a toolbar: 
Mouse 
• Click the right mouse button anywhere over a 

displayed toolbar. 

• The resulting menu will indicate the toolbars 
currently displayed. These are marked with a tick 
symbol. Click the toolbar you want to hide. 

 
 Figure 3 - Toolbars List 



Horizontal and Vertical Ruler 
Horizontal and vertical rulers are displayed on the left and across the top of the document 
window. 

 

You can use the horizontal ruler to view and set paragraph indents, tab stops, page 
margins and column widths. 

In Print Preview and Print Layout view, Word also displays a vertical ruler you can use to 
adjust top and bottom page margins and row height in tables. 

 

 To show or hide the horizontal ruler: 
Mouse 
• From the View menu, select Ruler. 

 

Status Bar 
The status bar is a horizontal area in Word below the document window. It provides 
information about the current page and positioning of the cursor and additional contextual 
information.  

 

Information on the Status bar reading from left to right tells you: 

 

• The page you are currently positioned on 

• The section you are currently positioned in 

• The total number of pages 

• The cursor position in relation to the top edge of your page 

• The line position (horizontal) and the column position (vertical) 
of the cursor 



 To show or hide the status bar: 
Mouse 
• From the Tools menu, select Options. 

• Select the View tab, and then select the Status bar check box. 

 

Scrollbars 
The Scrollbars are located along the right and bottom of the document window. They 
enable you to move to another part of the document by dragging the box or clicking the 
arrows in the scroll bar. 

Task Pane 
A task pane is a window that collects commonly used actions in one place. The task pane 
enables you to quickly create or modify a file, perform a search or view the clipboard. 

It is a Web-style area that you can  either dock along the right or left edge of the window 
or float anywhere on the screen. It displays information, commands and controls for 
choosing options. Like links on a Web page, the commands on a task pane are 
highlighted in blue text, they are underlined when you move the mouse pointer over 
them, and you run them with a single click.  

 

 Figure 4 - Task Pane 

A task pane is displayed automatically when you perform certain tasks, for example when 
you choose File, New commands from the menu bar to create a new document. 

 



 To display a task pane at any time: 
Mouse 
• Choose View, Task Pane from the menu bar. 

Or 
• Choose View, Toolbars, Task Pane from the menu bar. 

Or 
• Right-click the menu bar or any toolbar and choose Task pane 

from the shortcut menu. 

 

 

You then need to navigate to the particular task pane you want to work with. You can 
display any of the task panes that are available by clicking the down arrow near the 
upper right corner of the pane that is displayed initially, and choosing the name of the 
pane you want to open from the drop-down menu. 

 

 Figure 5 - Task Pane List 

You can navigate among the task panes you have recently displayed by clicking the Back 
and Forward Web-style buttons. Close the task pane by using the close button. 

 

View Buttons 
Microsoft Word has different ways for you to view your work, depending on the task at 
hand. You can switch between those views at the bottom left corner of the Word screen. 



 

Figure 6 - Smart Tag
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The views are covered in depth later. 

Smart Tags 
Smart Tags make it easier for you to complete some of the most common tasks and 
provide you with more control over automatic features.  

 
You do not have to complete any additional steps to make the Smart Tags appear or 
disappear in Word. The Paste Options and AutoCorrect Options smart tags will appear 
automatically to allow you to quickly choose actions and remain in place until you begin 
another action. For example, when you complete a paste operation, the Paste Options 
smart tag remains in place alongside your text until you begin typing new text.  

 

 To turn off Smart Tags 
Menu 
• Choose Tools, AutoCorrect Options from the menu bar. 

• Select the Smart Tags tab.  

• Clear the Show Smart Tag Actions buttons check box.  

• Click OK.  

Note: Turning off any of the Smart Tag buttons will make that action 
unavailable across all the Office programs where it is an option e.g. if you 
turn off the AutoCorrect button in Word, the AutoCorrect button will also 
be turned off in PowerPoint. 

 



Browse Object  
You can scroll through a document more quickly by selecting Browse Object  on the 
vertical scroll bar. It enables you to go to a page, bookmark, 
footnote, table, comment, graphic, or other location by selecting the 
item you want.  

You can click Next    or Previous   to go to the next  or previous 
item of the same type. 

Microsoft Word Help 
Word offers several quick ways to get help when performing particular tasks. You can 
select from a list of topics provided by Help, or you can even type a help request in plain 
English, and Word will supply the answer using the Answer Wizard.  

The Office Assistant 
In Word 2003, you can use the Assistant to get help quickly by typing plain English 
questions or phrases. 

 Figure 7 - The Office  
Assistant

 

 To use the Asistant: 
Mouse 
• Choose Help , Show the Office Assistant from the menu bar to 

turn the assistant  on if it has not been turned on. 

• When the Assistant is turned on, you can quickly display the 
Assistant and its balloon by choosing Help, Microsoft Word Help 
from the menu bar, by clicking the Help toolbar button, or by 
pressing F1 on the keyboard. 

Note: To hide the Office Assistant balloon, click the Assistant again. 

• Type a question or phrase and click the Search button. 

• Scroll through the topics, if necessary, by clicking on See More or 
See Previous, then click on the required topic. The help text will 
be displayed in the Help Window. 

 Figure 8 - The Assistant Balloon 



Ask a Question Box 
Word 2003 provides a convenient new alternative to using the Office Assistant, the Ask a 
Question box. You can get help by typing a question or phrase into Ask a Question and 
pressing [ENTER]. You will find Ask a Question in the upper-right corner of the 
application window. 

 

 

If you want to repeat a question you have already typed during the current session, you 
can simply select the question from the drop-down list accessible via the down arrow on 
the Ask a Question box. 

 Figure 9 - Ask a Question 

 

 Figure 10 - Ask a Question List  

 

The Help window 
The Help Window provides more options than either the Office Assistant or Ask a 
Question.  

 To access the Help Window: 
Mouse 
• Ensure that the Office Assistant is turned off and choose Help,  

Microsoft Word Help from the menu bar, or click the Help 

toolbar   button, or press F1. 



 
 Figure 11 - Microsoft Word Help   

• Type the search help criteria in the Search area and choose the 
green arrow to start the search 

• Select a displayed result link to view the help file 

 

Notes 
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